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Chapter 1 

Overview 

 

Introduction 
Do you know how much load your Web servers can handle?  Do you know if there are any 
dead URLs in your site?  Are you continuously throwing money at the web site? Can you 
predict when you will need to upgrade again? 

With WebSpray™, the days of guessing are over.  Using a simple and intuitive user interface, 
this powerful, easy-to-use tool allows you to stress-test your Web server or farm of servers.  
All you need is to enter the hostname or IP address of the Web server, and the results are a 
click away. 

Quantified Results 
WebSpray generates two reports: 

• URL report:  This is a report of all URLs found via a scan of the web site.  If there are 
any URLs in error, they will appear in this report, and can be viewed separately.  The 
default name of the file containing this report is scan.txt and its default location is \My 
Documents\WebSpray.   

• Performance report:  This is an in-depth performance report that calculates the 
minimum, maximum, and average, and standard deviation for the connect time, for the 
download time, and for the number of bytes downloaded.  In addition, it reports the 
total document body bytes downloaded, the total document header bytes downloaded, 
the document throughput in bytes per second.  The default name of the file containing 
this report is spray.txt and its default location is \My Documents\WebSpray. 

Test Controls 
There are a number of controls that can be imposed when testing: 
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• Target web site search:  WebSpray will test all the pages found on the target web site, 
or only specified pages.  WebSpray will report any broken links it finds during this 
process. 

• Testing with multiple clients:  WebSpray is capable of simulating up to 1,000 clients 
from a single IP address, and is also capable of using multiple IP addresses, with or 
without aliases.  WebSpray’s  simultaneously from multiple workstations to maximize 
the load that can be placed on you Web server. 

• Test over time:  To give your Web server a fully stressful work out, WebSpray lets 
you to choose how many times each client will test the selected pages, or how long the 
test should last. 
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Installing and Registering 
WebSpray 

Operating Requirements 
The PC on which you run WebSpray must meet the following minimum operating 
requirements: 

PC Hardware 
The PC must meet the following hardware configuration: 

• A Pentium class CPU.  The higher the CPU performance, the more the Web server can 
be stressed 

• A compatible Windows version (as listed in section below) 
• 64 megabytes of RAM 
• 20 megabytes of disk space 
• A Network Interface Card if testing will be over a Local Area Network or broadband 

connection, or 
• A modem if testing will be over a dialup connection. 

Windows Operating System Version 
One of the following Windows versions must be installed: 

• Windows 98 (SP2, SE) 
• Windows NT 4.0  
• Windows 2000  
• Windows XP 
• Windows 2003 

Network Connection 
One of the following network connections must be available: 
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• Local Area Network 
• Internet connection T1, T3 or broadband 
• Dial-up modem through any ISP  

Installation Procedure 
WebSpray installs and registers as a normal Windows application.  A system reboot is 
normally not required. 

New installation 
Load the WebSpray CD and run the installation program, wssetup20.exe.  Follow the 
instructions on the screen to complete the installation. 

Upgrade Installation 
Load the WebSpray CD and run the installation program, wssetup20.exe.  The installation 
program will detect the existing install and prompt you to Modify it. Follow the instructions on 
the screen to complete the upgrade. 

Trial Versus Licensed Version 
WebSpray can run either as a trial or licensed version.  The capabilities of a trial version are 
constrained, whereas a licensed version has no constraints. 

For trial and licensed versions, the program is the same but trial versions expire 30 days after 
installation. 

For a trial version, the days remaining in the trial period is shown in the program title and the 
About WebSpray box.  For licensed versions, the name of the licensee is shown in the About 
WebSpray box. 

Licensing Procedure 
WebSpray is normally sent as a trial version for testing.  A trial version runs for 30 days and 
then expires. 

A trial version may be converted to a licensed version by applying a license key provided by 
CAI Networks, Inc. upon payment of a license fee.  The Registration screen below is used for 
registering WebSpray on the computer on which it is installed.  You provide licensing 
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information to CAI Networks, Inc. or its reseller and then receive a validation key to convert 
the trial version into a non-expiring production version. 

 

De-installation Procedure 
WebSpray will deinstall cleanly via the Uninstall program.  To uninstall WebSpray, run the Uninstall 
program and follow the prompts on the screen.
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WebSpray Operation 

Introduction 
WebSpray tests Web servers by generating a high volume of connections and page retrievals 
against the pages they contain.  Which Web servers to test and which pages to retrieve are set 
as configuration options, as well as the volume and duration of testing. 

Modes of Operation 
WebSpray performs these tests in two phases: 

• In the first phase, the Web servers are accessed and all qualifying pages are identified 
• In the second phase, the pages qualified in the first phase are read 

The first phase of WebSpray testing is called scan mode; the second is called spray mode.  
These two modes are independent in that a Web server may be scanned once and then sprayed 
multiple times using different options. 

Scan mode 
In scan mode, WebSpray reads the head page of the Web server, determines all the links it 
contains, and then follows those links to all subsequent pages and the pages they link to.  
Through this method, WebSpray is able to “crawl” an entire web site and determine all the 
pages it references. 

All URLs found during scanning are saved for subsequent spraying, and all broken links found 
in the process are identified and reported. 

Statistics are gathered during scanning and reported upon completion of scanning, along with 
all broken links, in the scan results pane and in the scan results report. 

Spray mode 
In spray mode, WebSpray reads pages qualified by the scan for as many times and for as long 
as dictated by configuration settings.  WebSpray will either spray all qualifying pages, or you 
may instruct WebSpray to spray only certain pages. 
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Statistics are gathered during spraying and reported upon completion of spraying in the spray 
results pane and in the spray results report. 

Scope and Volume for Testing 
In testing with WebSpray, you have control over what pages are tested and how much testing is 
done.  You can simulate 1,000 users reading an entire Web server ten times, or a single user 
reading a single page over and over for a period of a week. 

Default Scope of Scanning 
WebSpray’s default scope for scanning varies based on how the Web server was specified: 

• If the Web server was specified by URL, all pages whose starting URLs match the 
specified URL are qualified 

• If the Web server was specified by IP address, all pages linked from that IP address are 
qualified 

By default, pages located outside of the current Web server are not qualified. 

Overriding Default Scope of Scanning 
WebSpray’s default behavior is effective for most Web servers, but you may find situations in 
which you want to override the defaults, for example: 

• A Web server is specified by URL and links to pages on the same server but under a 
different URL. 

• A Web server automatically redirects to another server. 
• A Web server links to other pages on other servers  

A number of controls are available to control which pages that WebSpray will read while 
scanning.  You can specify that WebSpray should: 

• Qualify only pages that match the full URL or only on the domain name 
• Restrict scanning only to pages located in the specified domain or follow links that 

point to other servers 
• Follow foreign links to a specified depth only 

These restrictions are imposed via configuration options. 

Restricting Scope of Spraying 
For spraying, you may choose to spray all pages qualified by the previous scan, or you can 
select from among the pages qualified in scan and spray only those. 
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Throttling Spraying Volume 
The volume of transactions that are generated when spraying can be set in the following ways: 

• Pages to spray 
• Number of simulated users 
• Duration of scanning, specified by time or iterations 

Windows GUI Versus Command-Line Interface 
WebSpray is comprised of two different programs offering approximately the same 
functionality but with two different user interfaces: 

• A Windows GUI program, intended for interactive use 

• A DOS command-line program, intended for batch use 

With minor exceptions, both programs offer the same functionality and performance. 

Windows GUI Program 
The Windows GUI program can be used for both ad-hoc and repetitive tests and has features 
designed to quickly facilitate both: 

• The most popular configuration options and all execution options are available on the 
main screen to quickly and easily make changes 

• Defaults for all configuration options can be easily set and reset as desired 

• Named configuration profiles can be easily created to establish different testing 
profiles, and you can be easily switched between 

Command-Line Interface Program 
The command-line interface program can be used to perform WebSpray operations in 
background mode.  In the CLI program, all settings are declared explicitly via command 
switches. 

Windows GUI layout 
The Windows GUI version main screen looks like this: 

WebSpray User Guide 9 



Chapter 3 

 
 

This interface contains the following elements: 

• Configuration frames for specifying: 
• Web Server settings 
• Proxy Server settings 
• Execution Options  
• Results File names and locations 

• Buttons for performing the following actions: 
• Scan qualifying pages to determine the URLs they contain 
• Show URLs in Error (e.g., broken links) 
• Spray All detected URLs 
• Spray Selected URLs only 
• Exit the program 

• Scan Results pane 

• Spray Results pane 
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• Progress bar to show execution progress 

• Menubar with functions for: 
• Managing and selecting profiles 
• Configuring all options and setting defaults 
• Performing actions 
• Getting Help 

All main-screen functions are also available from menu options. 

Windows GUI operation 
The Windows GUI version is used in the following way: 

1 Specify configuration settings (either explicitly or by loading a pre-set configuration 
profile) 

2 Perform a scan based on the configuration settings 
3 Perform a spray based on either all qualifying URLs or only specified URLs (selected 

via highlighting in the scan results pane) 
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Configuring a Test using the 
Windows GUI Program 

Setting Configuration Options 
The first step in performing any WebSpray test is to set the configuration options for the test.  
There are three ways to set configuration options: 

• From the main screen 
• From the Options menu 
• From a configuration profile 

These methods may be used alone or in combination. 

The configuration options on the main screen are synchronized with those in the Options menu 
such that modifying either will have the same effect (and be automatically shown in both 
places). 

You may also load a configuration profile and then override any of those settings from the 
main screen or the Options menu.  You may then, if you wish, update the chosen configuration 
profile using the new settings, or create a new profile based on those settings. 

Note You may reset the default configuration values at any time, and such new defaults will 
be imposed immediately and from then on. 

Configuration Profiles 
Configuration profiles provide an easy means of creating various configuration environments 
and reusing those environments, rather the explicitly establishing the desired settings every 
time. 

Note To manage configuration profiles, use the Load Profile, Save Profile, and Delete 
Profile options from the File menu.  You can either specify the path and filename of 
the file, or browse to the path by hitting the Browse button. 
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Default Configuration Settings 
WebSpray is supplied with factory default configuration settings that reflect typical values.  
You may wish to override these values and have your chosen values be imposed as new 
defaults.  To do so, use the Save as Default button on the various screens from the Options 
menu. 

Note If you override the factory default settings and save them as defaults, those factory 
settings are lost. 

Configuration Options 
WebSpray Windows GUI configuration options specify the following: 

• Web site to test, which port number to use, and login details if authentication for the 
Web server is required 

• If the web site is specified by URL, whether pages matching the full URL or just the 
domain name should be qualified 

• Whether links that point outside the web site (foreign links) should be followed 

• If foreign links should be followed, for how many levels of depth should they be 
followed 

• Proxy server and port to use, and login details if authentication for the proxy server is 
required 

• Which IP addresses configured on the WebSpray PC should be used, for tests that 
require different source IP addresses 

• Which browser to emulate 

• Which protocol should be used (HTTP or HTTPS) when reading the head page of the 
web site 

• Number of threads that should be used, for simulating simultaneous users 

• Whether execution duration is controlled by loop count or running (wall) time and the 
number of iterations or running time, respectively 

• Names and locations for WebSpray’s scan and spray results files 

The most popular of these options are accessible from the main screen; all options are available 
from the Options menu. 
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Configuring Target Web Server 
The Web Server is the target server that will be tested by WebSpray.  You need to specify at 
least the URL or address of the server and, for servers that require authentication, the login 
information. 

This option is available from the Web Server frame on the main screen.  It is also available 
from the Target Web Server option of the Options menu: 

 

The Web Server option has the following suboptions: 

Web server 
This identifies the Web server to test.  It can be specified in one of the following ways: 

• The IP address of the Web server 
• A URL that is resolved by an internal DNS server, or an external DNS server if the 

server is accessible via the Internet 
• A name that can be resolved within an internal network, such as a netbios name 

Note If you are using WebMux for load balancing multiple Web servers and want to use 
WebSpray against a WebMux server farm, enter the IP address configured for the 
farm. 

If the Web server is specified by IP address or URL, it may be optionally prefixed with 
“HTTP” or “HTTPS” to specify the protocol to use for the head page.  The head page protocol 
may alternately be specified using the Protocol for Head Page option.  If no protocol is 
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specified, WebSpray will use HTTP protocol; if the server uses a secured (SSL) head page, you 
must specify HTTPS protocol.  (This is the same behavior used by browsers.) 

The Web server may optionally be suffixed by the port number on the Web server that 
WebSpray should use for its communication.  If no port number is appended, it must be 
specified in the Port number field immediately following. 

Port 
Enter the port number on the Web server to be tested that WebSpray should use for its 
communication.  The default port is 80. 

Note This option is disabled if the port number was appended to the URL or IP address 
specified in the Web server box 

Web server requires user login 
If the specified Web server requires a user login, tick this checkbox. 

User ID 
Specify the user ID required for Web server access.  Be sure to use the same case (upper versus 
lower) that the proxy server expects. 

Password 
Specify the password associated with the User ID required for Web server access.  Be sure to 
use the same case (upper versus lower) that the proxy server expects. 

Configuring Target Scope 
This option determines which pages will be read in scan mode.  You can restrict scanning to: 

• Qualify only pages that match the full URL, if the Web server was specified by URL 
• Qualify pages that match on the domain name 
• Follow links that point outside of the specified Web server 
• Follow all foreign links 
• Follow links to a specified depth 
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To impose any of these restrictions, use the Target Scope option from the Options menu: 

 
The Target Scope option has a number of parameters: 

Pages to Qualify 
This option allows you restrict WebSpray from qualifying certain pages while scanning, for 
Web servers specified by URL. 

Enable the radio button that corresponds to what pages you want WebSpray to qualify: 

Qualify only pages that match the full URL 
WebSpray will compare the URL of each page encountered against the URL specified for 
the Web server and qualify the page only if its URL contains the full URL specified for the 
Web server.  This is the default case. 

Qualify pages that match on domain name 
WebSpray will compare the domain name portion of each page encountered against the 
domain name portion of the URL specified for the Web server and qualify the page only if 
its domain name matches the specified Web server’s domain name. 

Note This feature is disabled if the Web server is specified by IP address, netbios name, or 
other method 
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Foreign Links Handling 
By default, WebSpray does not follow any links that point outside of the specified Web server.  
Enabling this option will cause WebSpray to follow foreign links, and permits you to specify to 
what depth WebSpray should follow links on the foreign server. 

Follow links that point outside of the specified Web Server 
Tick this checkbox if you want WebSpray to follow links that point outside of the specified 
Web server. 

Follow all links 
Enable this radio button if you want WebSpray to follow all foreign links and the links on 
the pages they point to, including those that in turn point to other foreign servers.  If this 
option is enabled, WebSpray will continue to follow all links on all pages encountered until 
all linked pages have been qualified. 

Follow foreign links to a dept of n levels only 
Enable this radio button if you want WebSpray to follow foreign links to a specified depth.  
If you enable this option, you need to specify the depth to which WebSpray will follow 
foreign links.  The allowable range is 1 to 10.  If, for example, you specify a value of 2, 
WebSpray will follow the first link to the foreign server and then all links contained on that 
page only. 

Configuring Client IP Addresses 
Typically, testing a Web server using a single client IP address is sufficient but in some cases it 
may be desirable to have WebSpray use more than one client IP address for testing.  For this 
reason, it is possible to configure WebSpray to use as many IP addresses as are configured on 
the WebSpray PC for testing.  WebSpray will randomly alternate between these multiple IP 
addresses when spraying, thereby simulating the behavior of different client PCs. 

This feature requires that the WebSpray PC be preconfigured with multiple IP addresses, which 
is a feature of the Windows operating system (refer to Appendix for instructions on how to 
accomplish that). 

To configure multiple client IP addresses to be used by WebSpray, use the Client IP Addresses 
option from the Options menu: 

[screen shot] 

Each IP address assigned to the WebSpray PC is listed with a checkbox for each.  Tick the 
checkbox for each IP address you want to include for WebSpray testing. 
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Note This option is disabled if there is only a single IP address assigned to the PC 

Configuring Proxy Server 
This option is used to configure network access for WebSpray via a proxy server, if such is 
required.  

This option is available from the Proxy Server frame on the main screen.  It is also available 
from the Proxy Server option of the Options menu: 

 

Use Proxy Server 
If your network requires you to use a proxy server to get access, tick this checkbox. 

Proxy Server 
Specify the proxy server to use by specifying one of the following: 

• The IP address of the proxy server 
• A URL that is resolved by an internal DNS server, or an external DNS server when 

testing originates on the Internet 
• A name that can be resolved from the internal network, such as a netbios name 

Port 
Enter the port number on the proxy server.  The default port is 8080. 
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Proxy Server Requires Authentication 
If the specified proxy server requires authentication, tick this checkbox. 

User name 
Specify the user ID required for proxy server access.  Be sure to use the same case (upper 
versus lower) that the proxy server expects. 

Password 
Specify the password associated with the User ID required for proxy server access.  Be sure to 
use the same case (upper versus lower) that the proxy server expects. 

Configuring Browser Emulation 
You may wish to perform WebSpray tests using different types of browsers.  To do so, use this 

 

option, which is accessible via the Browser Emulation option on the Options menu: 

By default, WebSpray emulates Internet Explorer 5.5 

Configuring Protocol for Head Page 
 page (head page) is secured (meaning it 

 
For tests against Web servers where the starting
requires an SSL connection), WebSpray must be told this in order to correctly process the site.

The protocol to use for the head page can be specified either using the Protocol for Head Page 
option or by prefixing the URL or IP address in the Web Server option with either “HTTP” or 
“HTTPS”.  (If the URL is prefixed, the Protocol for Head Page option is disabled.) 
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If the protocol is not specified, HTTP is used. 

Note The configured protocol is only used for the head page.  Correct specification of the 
head-page protocol is required since WebSpray (like browsers) is not able to tell which 
protocol to use.  For pages beyond the head page, WebSpray is able to automatically 
determine the correct protocol to use and does so.   

Configuring Thread Count 
This option is used to configure how many concurrent accesses should be made to the Web 
server, to simulate that number of users. 

This option is accessible in the Execution Options frame on the main screen and the Thread 
Count option of the Options menu: 

 

Thread Count 
Specify the number of concurrent accesses that should be made.  The range is 1 to 1000; the 
default is 15. 

This value may alternately be set by moving the indicator on the slider bar to the left or right.    
As the indicator is moved to the left or right, the corresponding values are reflected in the box. 

Configuring Execution Duration 
This option specifies how long a spray should run for, either by number of iterations or time.  
The spray will automatically terminate once this has been reached. 

This option is accessible in the Execution Options frame on the main screen and the Execution 
Duration option of the Options menu: 
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If specified as a loop count, WebSpray will loop through the qualifying pages and spray each 
consecutively for the specified number of times. 

If specified by duration, WebSpray will follow the same method as for loop count but stop 
when the time limit has been reached. 

This option is accessible in the Execution Options frame on the main screen and the Execution 
Duration option of the Options menu. 

Loop Count 
Specify the number of times WebSpray should spray qualifying URLs.  The range is 1 to 1000; 
the default is 1. 

To adjust the value, first enable this option by clicking on the radio button next to it, then enter 
a numeric value into the box. 

This value may alternately be set by moving the indicator on the slider bar to the left or right.    
As the indicator is moved to the left or right, the corresponding values are reflected in the box. 

Running Time 
Specify how long the spray is to run, either in seconds, minutes, hours, or days.  The default is 
15 seconds; the maximum is 7 days. 

To adjust the value, first enable this option by clicking on the radio button next to it, then enter 
a new numeric value in the first drop-down box and select the time measurement from the 
second drop-down box. 
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These values may alternately be set by moving the indicator on the slider bar to the left or 
right.  The slider is divided into fourths, where the first increment represents seconds, the 
second minutes, the third hours, and the fourth days.  As the indicator is moved to the left or 
right, the corresponding values are reflected in the boxes. 

Note If you attempt to specify more than the maximum duration of 7 days, the boxes are 
automatically adjusted to the maximum allowable duration 

Configuring Results Files 
Once a scan or spray has completed, the results are displayed on the main screen and also 
written to two files.  This option is used to override the default filenames and/or locations for 
these files. 

This option is accessible from the Result Files frame on the main screen and the Results Files 
option on the Options menu: 

 

Scan Results File 
Specify the path and filename where the results of the scan are to be stored, or browse to the 
path by hitting the Browse button. 

The scan results file is by default named ScanResult.txt and located in the \Reports 
subdirectory of the WebSpray installation directory, which is by default \Program Files\CAI 
Networks\WebSpray. 

Spray Results File 
Enter the path and filename where the results of the stress test are to be stored, or browse to the 
path by hitting the Browse button. 

The spray results file is by default named SprayResult.txt and located in the \Reports 
subdirectory of the WebSpray installation directory, which is by default \Program Files\CAI 
Networks\WebSpray. 
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Testing with the GUI Program 

Overview 
Testing a Web server via the WebSpray GUI program is a two-stage process: 

• Scan the Web server for qualifying pages via the Scan option 
• Spray qualifying or selected pages  

The scan information is saved, permitting you to perform multiple sprays based on the same 
scan result.  In addition, each spray can be configured to automatically perform multiple 
iterations based on configuration settings. 

WebSpray also supports configuration profiles, allowing you to save current configuration 
settings for re-use at a later time.  This is particularly useful if you want to use different 
configuration settings for different tests and do not want to specify them each time. 

WebSpray Actions 
WebSpray actions accomplish the following: 

• Scan for qualifying pages 
• Show URLs in error 
• Spray all qualifying pages 
• Spray selected (qualifying) pages 
• Exit the program 
• Get help 
• Display WebSpray Version  
• Display WebSpray Licensing Information 

The most popular of these actions are accessible from the main screen; all actions are available 
from the File, Actions, or Help menus. 
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Scan for Qualifying Pages 
To scan the specified Web server for all accessible URLs based on the current configuration 
settings, hit the Scan button on the main screen or use the Scan option from the Actions menu. 

WebSpray will scan all qualifying pages and show all URLs found in the scan results pane and 
in the specified scan results file.  Any URLs that have returned errors, due to broken links are 
other problems, are shown.  During scanning, the progress bar is dynamically updated to show 
the progress of the scan. 

Once the scan is complete, you can show URLs in error or proceed to spray the “good” URLs.  

Show URLs in Error 
The Show URLs in Error button is enabled if any URLs found in scan have returned errors, due 
to broken links or other problems. Hit this button to display those URLs, or use the same-
named option from the Actions menu. 

Spray All Qualifying Pages 
To start the test so that it will access all the URLs found in the scan (except those in error), hit 
the Spray All button or use the same-named option from the Actions menu. 

During spraying, the progress bar is dynamically updated showing the progress of the spray. 

When the test is complete, the results are shown in the Spray results pane.  These same results 
are written to the file specified as the spray results file. 

Note You must perform a scan before you can spray.  The Spray All button on the main 
screen and the Spray All option of the Actions menu are disabled if a scan has not been 
performed 

Spray Selected Pages 
To test only certain URLs for spraying: 

• First select the desired URLs from the list that appears in scan results pane by clicking 
on them, which will highlight them. You can select multiple entries by Ctrl-click (for 
non-contiguous entries) or Shift-click (for contiguous entries) 

• Then hit the Spray Selected button to start spraying or use the same-named option from 
the Actions menu. 
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During spraying, the progress bar is dynamically updated showing the progress of the spray. 

When the test is complete, the results are shown in the Spray results pane.  These same results 
are written to the file specified as the spray results file. 

Note You must perform a scan before you can spray.  The Spray Selected button on the main 
screen and the Spray Selected option of the Actions menu are disabled if a scan has not 
been performed.  These features are also disabled if a scan has been performed but no 
URLs have been selected 

Exit the Program 
To exit the WebSpray Windows GUI program, hit the Exit button on the main screen or use the 
Exit option from the File menu. If there is a scan or spray in process when you attempt to exit 
the program, WebSpray will confirm that you really want to exit. 

Note If exiting the program and you have loaded a configuration profile and modified any of 
the settings without saving the profile, you will be prompted as to whether or not to 
update the profile based on the current settings 

Get Help 
To access WebSpray’s help file, use the WebSpray Help option from the Help menu. 

Display WebSpray Version 
To display version information of the installed WebSpray release, use the About WebSpray 
option from the Help menu. 

Display WebSpray Licensing Information 
To display licensing information of the installed WebSpray release, use the About WebSpray 
option from the Help menu.  For trial versions, the number of days remaining in the trail period 
is shown; for licensed versions, the name of the licensee is shown. 

WebSpray User Guide 27 





 

Chapter 6 

Using the Command Line 
Interface 

Introduction 
Like the Windows GUI program, which separates scanning and spraying into two distinct 
phases, the command-line-interface program, wspray.exe, also requires two separate command 
operations to scan and spray. 

With the command-line-interface program, you first use the scan command option to create a 
file containing qualifying URLs, followed by the spray command option to refer to the URL 
file created by the scan.  Command switches are used to specify various options for spray and 
scan.  Results can be found in results files created by the scan and spray. 

Configuration and Run Options 
WebSpray command-line-interface program configuration options specify the following: 

• Web site to test, which port number to use, and login details if authentication for the 
Web server is required 

• If the web site is specified by URL, whether pages matching the full URL or just the 
domain name should be qualified 

• Whether links that point outside the web site (foreign links) should be followed 
• If foreign links should be followed, for how many levels of depth should they be 

followed 
• Proxy server and port to use, and login details if authentication for the proxy server is 

required 
• Which protocol should be used (HTTP or HTTPS) when reading the head page of the 

web site 
• Number of threads that should be used, for simulating simultaneous users 
• Whether execution duration is controlled by loop count or running (wall) time, and the 

number of iterations or running time, respectively 
• Whether a scan or spray is to be performed 
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• Names and locations for WebSpray’s scan and spray results files 

Invoking the Command-Line-Interface Program 
The command line interface program (CLI) is named wspray.exe and is located in the directory 
in which WebSpray was installed. 

You must run the CLI either from Start | Run … or from within a DOS box. 

A quick method of getting an open DOS box in the WebSpray installation directory is provided 
from the Windows Start menu via CAI Networks | WebSpray | WebSpray command line: 

Invoking that feature does the following: 

• Opens a DOS box 
• Changes directory to the WebSpray installation directory 
• Displays the command-line-interface program’s help screen 

You can then run the CLI from the installation directory and specify its options. 

Command Syntax 
WebSpray command-line-interface program (CLI) commands are specified positionally and 
via command switches.  Scan and spray commands share some common options and are 
differentiated by the inclusion of the “scan” or “spray” token on the command line. 

The wspray CLI command has two forms: 

wspray.exe scan-options [general-options] scan scan-result-file 
wspray.exe spray-options [general-options] spray spray-result-file 

where 

scan-options are: 
-s server Web server to test 
-p port Web server port to use 
-S Use HTTPS protocol for head page 
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-U [protocol://]url[:port] URL of start page for testing and optionally protocol 
to use for head page and Web server port to use 
(overrides -s, -p, and -S options)  

-d Qualify only pages whose domain name matches the 
specified Web server domain 

-fd [depth]   Traverse foreign links to a specified number of levels 

scan-result-file Pathname of file in which to write scan results 

spray-options are: 
-sf scan-file Specifies file containing URLs to spray 
-th thread-count Number of threads to use when spraying  
-l loop-count Number of times to spray the URLs (cannot be 

specified with -th) 
-t duration increment Running time for spray (cannot be specified with -l) 

spray-result-file Pathname of file in which to write spray results 

general-options are: 

-u username password User name and password to use for Web server login 
-P proxy-server Hostname or IP address of proxy server 
-Pp proxy-server-port Port number on the proxy server to use 
-Pu username password User name and password to use for proxy server login 
-B browser Browser type to emulate 

-IP addr1,...,addrN List of IP addresses to connect from 

Note WebSpray command options (switches) are case-sensitive 

Command options 
The following paragraphs detail the WebSpray CLI command options, parameters, and usage 
by function.  They are grouped by below into scan options, spray options, and general options. 

Scan Options 
Scan options are used when scanning and are only imposed when the “scan” token is included 
in the wspray command. 
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Specifying Target Web Server 
The target Web server that will be tested by WebSpray is a required option and may be 
specified either by the IP address or host name of the Web server or the URL of the page to 
start with.  (The discussion herein is for specifying the Web server via IP address or host name; 
for specification by URL, refer to the discussion in the next section.) 

If the Web server requires authentication, the login information must be specified (via the -u 
option). 

Web server 
The -s option specifies the Web server to test.  It can be specified either by URL or IP address. 

The format of this command option is: 

 -s server 

where server is either the IP address or host name of the Web server to test. 

Port 
The -p option specifies the remote port to use (on the specified Web server).  If the -p option is 
not specified, the CLI will use port 80 for HTTP protocol and port 443 for HTTPS protocol. 

The format of this command option is: 

 -p port 

where port is the port number to use on the specified Web server. 

Protocol 
By default, WebSpray imposes HTTP protocol for the starting (head) page on the specified 
Web server.  If the starting page requires the use of HTTPS protocol, use the -S option. 

The format of this command option is: 

-S 

If the -S option is not specified, HTTP protocol is used for the starting page. 

Note The target Web server may also be specified via the -U option, which specifies the 
URL of the starting page and optionally the Web server port number to use and 
protocol to use for the head page. 
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Specifying Starting Page by URL 
The target Web server that will be tested by WebSpray is a required option and may be 
specified either by the URL of the page to start with or the IP address or host name of the Web 
server  to test.  (The discussion herein is for specifying the Web server via URL; for 
specification by IP address or host name, refer to the discussion in the previous section.) 

If the Web server requires authentication, the login information must be specified (via the -u 
option). 

The -U option specifies the URL of the starting page to use when scanning, and optionally the 
protocol to use for the head page and remote port to use. 

The protocol to use when accessing the head page may optionally be specified by pre-pending 
it to the URL or IP address.  If the protocol is not specified, HTTP protocol is used; if the head 
page is secure, you must specify that by pre-pending the URL with “HTTPS://”. 

The remote port (on the Web server) may optionally be specified by port number.  If the 
remote port is not specified, WebSpray will use port 80 for HTTP protocol and port 443 for 
HTTPS protocol. 

The format of this command option is: 

 -U [protocol://]url[:port] 

where 

protocol is optional and is either “HTTP” or “HTTPS” 
url is required and either a URL or IP address 
port is optional and an integer value defining the port number of the Web server to use 

Specifying Scope of Pages to Test 
There are two command options, -d and -fd, that can be used to override the default scope of 
pages that wspray will qualify when scanning. 

By default, wspray will qualify only pages whose URLs match the full URL of the starting 
page.  The -d option instructs wspray to relax the URL match and qualify any pages 
encountered that that are within the domain as the starting page. 

Also by default, wspray will not follow any links that point outside of the Web server being 
tested.  Wspray can be instructed to follow external links – either all foreign links or only to a 
specified depth. 
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Match on Domain Name 
The -d option instructs wspray to qualify any pages encountered that are within the same 
domain as the Web server, regardless of whether their URLs match that of the starting page.  

The format of this command option is: 

 -d 

If the -d option is not specified, only pages whose URLs match that of the starting page are 
qualified. 

Follow Foreign Links (All or to a Specified Depth) 
The -fd option instructs wspray to follow links that point outside of the specified Web server 
and, optionally, the depth to which they should be followed. 

The format of this command option is: 

 -fd [depth] 

where depth specifies the number of levels of foreign links WebSpray should read, in a range 
of 1 to 10.  If depth is not specified, all foreign links are read. 

If the -fd option is not specified, links that point outside of the current Web server are not 
followed. 

Specifying Scan Result File 
Upon completion of a scan operation, wspray generates a file that contains a list of all the 
URLs encountered with result information about each.  This file serves two purposes: 

• It reveals the results of the scan and shows URLs in error 
• It is used as input for spray operations 

The scan-result-file is required and is specified as the last parameter on a scan command.  It 
may be qualified with a path; otherwise, it is created in the current working directory. 

Spray Options 
Spray options are used when spraying and are only imposed when the “spray” token is 
included in the wspray command. 
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Specifying Scan Result File (to Govern Spray) 
When spraying, you must point wspray to the file that contains the URLs collected during scan.  
This is done using the -sf option, a required command option when spraying. 

The format of this command option is: 

-sf scan-result-file 

where scan-result-file is the pathname of the scan result file.  If the scan-result-file is located in 
the current working directory, it can be specified by file name; otherwise, its full or relative 
pathname must be specified. 

Specifying Thread Count 
The -th command option is used for specifying how many concurrent accesses should be made 
to the Web server, to simulate that number of users.  If the –th option is not specified, wspray 
will use the default of 5 threads. 

The format of this command option is: 

-th thread-count 

where thread-count is an integer value between 1 and 1000. 

Specifying Execution Duration 
Execution duration for spraying can be specified either by the amount of time or number of 
consecutive times the spray should be executed (using the same scan-file), using either the -t or 
-l command option. 

When spraying, either –t or –l must be specified to instruct WebSpray how long to spray for. 

Note The -t and -l options are mutually exclusive:  only one or the other may be specified 

Specifying Execution Duration by Loop Count 
The -l option specifies how many times the spray should run consecutively.  WebSpray will 
stop once it has cycled through the URL list the specified number of times and report the 
results. 

The format of this command option is: 

-l loop-count  

where loop-count is an integer value between 1 and 1000. 
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Specifying Execution Duration by Running Time 
The -t option specifies how long a spray should run for.  WebSpray will stop once the time 
limit has been reached and report the results. 

The format of this command option is: 

-t duration increment 

where duration is an integer value which in combination with increment parameter may not 
exceed the equivalent of 10,000 minutes 

and increment is one of: 

sec Seconds 
min Minutes 
hour Hours 
day Days 

Specifying Spray Result File 
Upon completion of a spray operation, wspray generates a file that contains a report revealing 
the results of the spray operation. 

The spray-result-file is specified as the last parameter on a spray command.  It may be 
qualified with a path; otherwise, it is created in the current working directory. 

If the “spray” token is included in the command line but no spray-result-file is specified, the 
spray results are written to SprayResult.txt located in the \Reports subdirectory of the 
WebSpray installation directory. 

General Options 
General options are used when scanning or spraying and are imposed in all CLI operations 
(i.e., when either the “scan” or “spray” token is included in the wspray command). 

Specifying Web Server Login 
If the target Web server requires user authentication, the login information must be specified 
via the -u option. 

The format of this command option is: 

-u username password 
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where 

username is the case-sensitive user name for Web server login 
password is the case-sensitive password for Web server login 

Specifying Proxy Server 
If a proxy server is required for WebSpray to get network access, it must be specified along 
with login information if authentication is required.  This is specified using multiple command 
options. 

Proxy server 
The -P option specifies the proxy server to use.  It can be specified either by hostname or IP 
address. 

The format of this command option is: 

-P proxy-server 

where proxy-server is either a hostname or IP address. 

Proxy Server Port 
The -Pp option specifies the port number on the proxy server to use. 

The format of this command option is: 

-Pp proxy-server-port 

where proxy-server-port is an integer value that specifies the port of the proxy server wspray 
will use. 

If the -p option is used to specify a proxy server but the -Pp option is excluded, port 8080 will 
be used. 

Proxy Server Login 
The -Pu option specifies the user ID and password for logging into the proxy server.  This 
option is not required if the proxy does not require authentication. 

The format of this command option is: 

-Pu username password 

where 
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username is the case-sensitive user name for proxy server login 
password is the case-sensitive password for proxy server login 

Specifying Browser to Emulate 
Wspray is capable of emulating popular browsers.  By default, it emulates Internet Explorer but 
you may specify a different browser to emulate via the -B option. 

The format of this command option is: 

-B browser 

where browser is one of: 

Firefox Firefox version 1.0.3 
IE Internet Explorer version 6.0 
Netscape Netscape version 4.8 
Opera Opera version 8.0 

If this command option is not specified, wspray will emulate Internet Explorer version 6.0. 

Specifying Multiple IP Addresses 
By default, WebSpray will connect using the IP address assigned to the WebSpray PC.  If more 
than one IP address is assigned to the WebSpray PC, it is necessary to tell WebSpray which 
one(s) to use for testing  This is done via the –IP command option. 

The format of this command option is: 

-IP addr1,...,addrN 

where either a single IP address is specified, or multiple IP addresses are specified delimited by 
commas. 

If multiple IP addresses are assigned to the WebSpray PC and the –IP command option is not 
specified, WebSpray will use the primary IP address. 

Examples 
These commands scan a bank’s web site using https protocol for the head page and sprays it for 
five minutes using 10 threads: 

wspray –U https://www.bankofthewest.com/ scan bow_scan.txt 
wspray –sf bow_scan.txt -t=5 -th=10 spray bow_spray.txt 
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This command scans the same site but follows links to a depth of 2 levels on foreign sites 
linked to from the specified Web server: 

wspray –U https://www.bankofthewest.com/ -fd 2 scan bow_scan.txt 
wspray –sf bow_scan.txt -t=5 -th=10 spray bow_spray.txt 
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Sample Tests 

Testing examples 
This chapter contains some examples of common tests that are performed with WebSpray. 

Simple Out-of-the-Box Test 
WebSpray has default values set for most configuration settings so to perform a quick test you 
only need to specify the target Web server (either by host name or IP address) and then 
perform the scan and spray operations. 

 To configure an out-of-the-box test 
1 Specify the IP address or host name of the Web server in ‘Web server’ box 

2 Hit the Scan button 

3 When the scan is complete, hit the Spray All button 

This will test all qualifying pages on the specified Web server using default settings and report 
the results in the Scan Result window and Spray Result window 

Testing a Server Multiple Times 
By default, WebSpray will spray all selected pages one time.  While this is usually sufficient to 
provide representative results, factors such as connection speed variations, network traffic, site 
loading, etc. can skew results.  Therefore, WebSpray makes it easy to test a web site multiple 
times in sequence.  To do that, set ‘Loop count’ to the desired number of iterations. 

Alternately, WebSpray can limit the amount of time a spray will run.  If it has not sprayed all 
web pages before the time limit, it will report results for whatever pages it has sprayed, which 
should be indicative of the overall Web server performance.  If you want WebSpray to keep 
running until all pages have been sprayed, specify a high value for the ‘Running time’ option.  
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 To test a Web server multiple times in sequence 
1 Enable the ‘Loop count’ option by ticking its radio button  

2 Specify desired ‘Loop count’, either by entering it using the edit and listbox or via 
the slider beneath 

3 Scan and Spray 

 To test a Web server over specified time period 
1 Enable the ‘Running time’ option by ticking its radio button 

2 Specify the running time value in the edit box and select increments using the listbox, 
or use the slider beneath 

3 Scan and Spray 

Controlling Transaction Volume for Testing 
WebSpray lets you control the transaction volume used for testing by increasing or decreasing 
the number of threads used in testing, where the more threads that are used the higher the 
transaction volume.  This has the effect of simulating multiple users, since each thread runs 
independently and generates near-simultaneous transactions to the Web server. 

Note Increasing the thread count puts an extra burden on system resources on the WebSpray 
PC.  You may find that control of the PC may become sluggish if insufficient resources 
are available to service a high number of threads.  Should that happen, you would 
either need to decrease the number of threads or upgrade the WebSpray PC, or both.  

 To increase the thread count used when spraying 
1 Type in the desired ‘Thread count’ or use the up or down arrow to change the value 

2 Scan and spray 

Testing Selected Pages Only 
You can limit the pages on the Web server that are tested by selecting only certain URLs from 
the scan result.  (Alternately, you can scan all pages qualified by the scan). 

 To spray selected pages only 
1 Perform a scan 
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2 Select the URLs you want to spray by highlighting each one in the Scan Result pane 

3 Hit the Spray Selected button 

Testing Foreign Pages that are Linked from the Tested Server 
By default, WebSpray tests only pages on the specified server; but it is also possible for 
WebSpray to test links that point outside of the specified Web server and to follow those to a 
specified depth. 

 To follow foreign links and test foreign pages 
1 Select Target Scope from the Options menu 

2 Enable the ‘Follow links that point outside the specified Web Server’ option by 
ticking its checkbox 

3 Enable either radio button, to follow all foreign links (to infinite depth) or specify the 
depth to which foreign links should be followed 

4 Scan and spray 

Testing Via a Proxy Server 
If network access from the WebSpray PC is required to go through a proxy server, you will 
need to configure the proxy server for WebSpray usage.  If the proxy authenticates, you will 
need to provide the information for that. 

 To configure a proxy server for WebSpray usage 
1 Enable the ‘Proxy Server’ option by ticking its checkbox 

2 Specify the hostname or IP address of the proxy server 

3 Specify the port on which the proxy server communicates (the default is usually fine) 

4 If the proxy server requires authentication, enable the ‘Proxy server requires 
authentication’ option by ticking its checkbox 

5 Specify the user ID to login to the proxy server 

6 Specify the password for the user ID specified (may or may not be case-sensitive, 
depending on the proxy server) 

7 If WebSpray normally accesses via the configured proxy server, you may wish to 
create a profile with the proxy server information and use it every time you run 
WebSpray. 
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Testing Using Multiple IP Addresses 
By default, WebSpray tests only pages on the specified server; but it is also possible for 
WebSpray to test links that point outside of the specified Web server and to follow those to a 
specified depth. 

 To select IP addresses for WebSpray to use 
1 Select the ‘Client IP addresses…’ option from the Options menu.  (Note that this 

option is greyed if there is only a single IP address configured for the WebSpray PC.) 

2 Enable the IP addresses you want to use by ticking their checkboxes 

3 If you plan to use multiple IP addresses each time you run WebSpray, you may want 
to configure a profile for that and use it each time you run WebSpray.  If you want to 
alternate between different IP address configurations, you may want to set multiple 
profiles and alternate between them. 

4 Scan and spray 

Testing a WebMux “Web Farm” 
If you have a WebMux web farm, in which multiple web servers are represented by a single IP 
address (the IP address of the WebMux appliance), you perform a normal WebSpray test with 
some recommended settings. 

 To test a WebMux web farm it is recommended that you 
1 Specify multiple IP addresses for the WebSpray server. 

2 Increase the number of threads used when testing (since you are actually testing 
multiple web servers simultaneously) 

3 Scan and spray 
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Reporting 

WebSpray reporting 
Upon completion of a scan or spray operation, a resulting report is displayed in the 
corresponding pane on the main screen.  A copy of the report is also saved to a file for printing 
or for later reference. 

Scan Results 
Upon completion of a scan operation, a scan results report is displayed in the scan results pane 
on the main screen and a copy of the report is saved to a file.  The scan results file contains a 
list of all the accessible URLs on the specified Web server. 

The scan results report contains one entry for each qualifying page with related information.  
URLs in error are also shown. 

Scan Results Pane 
Upon completion of a scan, the Scan Results Pane reports summary results of the scan in a 
structured format, like this: 
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The following information is shown for each qualifying page: 

URL The full URL of the page 
Code Sever-generated numerical status code 
Text Sever-generated status comment 
Type Type of text content on the page 
Size Number of bytes contained in the page 

Scan Results File 
The scan results file contains a list of all the accessible URLs on the specified Web server. 

The scan results file is by default named ScanResult.txt and located in the \Reports 
subdirectory of the WebSpray installation directory, which is by default \Program 
Files\WebSpray. 

Spray Results 
Upon completion of a scan operation, a spray results report is displayed in the scan results pane 
on the main screen and a copy of the report is saved to a file. 

The spray results report contains performance-related statistics about the spray operation. 

Spray Results Pane 
Upon completion of a spray, the Spray Results Pane reports summary results of the spray in a 
structured format, like this: 
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The Spray Results report is divided into four sections: 

• The header section shows the basic statistics related to the report. 
• The Downloaded Data section reports information about the volume of data tested 

content, and total. 
• The Average Time section reports the timing statistics for the data tested. 
• The Throughput result reports the overall data throughput achieved in the spray. 

A detailed explanation of the report is below; how to interpret the report is described in the 
next section. 

Header 

The header section shows the basic statistics related to the report and includes: 

Duration Total amount of (wall) time that the spray ran 
 
Clients The number of Threads that were used for the spray 
Loops The number of iterations that were completed in the spray (as 

governed either by Loop Count or Running Time) 
 
Good Pages The number of pages that were included in the spray (no errors 

were found by scan)  
Bad Pages The number of pages that were excluded from the spray (errors 

were found by scan) 
SSL The percentage of pages sprayed that use HTTPS (Secure Socket 

Layer) protocol -- the remaining pages use HTTP protocol 

Downloaded Data 

The Downloaded Data section reports information about the volume of data tested, with 
minimum, maximum, and average volume shown separately for header content, body content, 
and total. 

Headers The volume of header data, in megabytes, that was read in the 
spray, as well as the percentage of data that was comprised by 
headers 

Body The volume of body data, in megabytes, that was read in the spray, 
as well as the percentage of data that was comprised by body 
content 
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Total The total volume of both header and body, in megabytes, that was 
read in the spray 

Average Time 

The Average Time section reports the timing statistics for the data tested, with minimum, 
maximum, and average volume shown for connection and download time, averaged across all 
data read. 

Connection The amount of time, in milliseconds, that the connection took to 
complete.  These statistics reflect the so-called TTFB (Time To 
First Byte), which is the amount of time that it took from the start 
of the connection request until the first byte of the page was read 

Download The amount of time, in milliseconds, that the download of all data 
on the page took to complete.  These statistics reflect the so-called 
TTLB (Time To Last Byte), which is the amount of time it took 
from the start of the connection request until the last byte of the 
page was read. 

Throughput 

The Throughput section reports the overall data throughput achieved in the spray, with 
minimum, maximum, and average. 

Throughput The data throughput rate, expressed as the number of bytes per 
second. 

The information shown reflects all pages tested.  Separate statistics are shown for the page 
having the least volume of data or taking the least amount of time (minimum), the most volume 
or time (maximum), the mean of all pages (average), and the standard deviation of results 
across all pages tested. 

Spray Results File 
The same information shown in the spray results pane is written to the spray results file. 

The spray results file is by default named SprayResult.txt and located in the \Reports 
subdirectory of the WebSpray installation directory, which is by default \Program 
Files\WebSpray. 
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Interpreting the Spray Report 
The Spray Report provides valuable information for determining whether the Web server you 
are testing is performing up to expectations, and helps reveal where problem areas may exist. 

Here are some things to look for in interpreting the report: 

• A high ratio of header data to body data could indicate that performance gains could be 
achieved by reducing the header space. 

• A high connection time could indicate that the Web server is too busy to quickly 
service connections or that the connection between the WebSpray PC and the Web 
server being tested is slow. 

• Extreme disparities between minimum, maximum, and average timings, as indicated 
by standard deviation, could indicate erratic Web server performance. 
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Appendix A 

Glossary 

This appendix contains terms used in this manual that the reader may not be familiar with and 
provides a definition of each. 

 

.wsp WebSpray profile file 

Broken link A link on a web page that points to a nonexistent page 

Domain name The name of a network domain, in the format domainname.extension 

Foreign link A link on a web page that points outside the current domain. 

Head page The first page WebSpray accesses on a Web server 

HTTP Traditional HTTP protocol 

HTTPS Secured HTTP protocol 

License Key A code supplied by CAI Networks, Inc. for converting a trial version of 
WebSpray into a licensed version 

Pane A windowed section of a screen.  WebSpray’s main screen contains a scan 
results pane and a spray results pane 

Proxy server A server through which TCP/iP traffic may pass for the purpose of 
providing caching, secured access, and other benefits 

Scan A WebSpray operation in which pages on a specified Web server are read 
and the links they contain are detected and extracted as URLs 

Serial number A unique ID assigned to each installed copy of WebSpray, used for 
identification and licensing purposes 

Spray A WebSpray operation in which web pages identified in a scan operation 
are read and the statistical results tabulated 

SSL Secured Sockets Layer protocol, which encrypts data before transmission 
and decrypts it after transmission using a supplied certificate 
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URL Unified Record Locator, which is a specially-formatted name used to 
uniquely identify web pages 
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Appendix B 

Windows Program Menu and 
Command-line Program 

Reference 

Windows Program Menu 
The following menus and options are available from the Windows GUI menubar. 

File Menu 
Load Profile Loads specified configuration profile 
Save Profile Saves current new or existing configuration profile 
Delete Profile Deletes specified configuration profile 
Exit Terminates the program 

 

Options Menu 
Target Web Server Specifies Web server to test with optional port to use and 

login info 

Target Scope Specifies pages to include and exclude from scan 
Client IP Addresses Specifies client IP addresses to use when testing 
Proxy Server Specifies proxy server for network access with optional 

login info 
Browser Emulation Specifies browser for WebSpray to emulate 
Protocol for Head Page Specifies protocol to be used for reading Web server head 

page 
Thread Count Specifies number of concurrent threads for testing 
Execution Duration Specifies loop count or running time for spray execution 
Results Files Specifies names and locations of results files 

 

Actions Menu 
Scan Scans specified Web server and identifies all qualifying 
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pages 
Show URLs in Error Lists URLs in error found during scan 
Spray All Sprays all qualifying pages 
Spray Selected Sprays specified pages 

 

Help Menu 
WebSpray Help Accesses WebSpray documentation 
About WebSpray Shows program version and licensing information 

Command-Line Program Switches and Parameters 
The following command switches and parameters can be specified for the command-line-
interface program: 

Scan Options 
-s server Specifies Web server to test 
-p port Specifies Web server port to use 
-S Causes wspray to use HTTPS protocol for reading Web 

server head page 
-U [protocol://] url[:port] Specifies URL of start page for testing and optionally 

protocol to use for head page and Web server port to use 
-d Causes wpsray to qualify only pages whose domain name 

matches the specified Web server domain 
-fd [depth] Causes wpsray to traverse foreign links to a specified 

number of levels 
scan-result-file Specifies pathname of file in which to write scan results 

 

Spray Options 
-sf scan-file Specifies file containing URLs to spray 
-th thread-count Specifies number of threads to use when spraying 
-l loop-count Specifies number of times to spray the URLs 
-t duration increment Specifies running time for spray 
spray-result-file Specifies pathname of file in which to write spray results 
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General Options 
-u username password Specifies user name and password for Web server login 
-P proxy-server Specifies hostname or IP address of proxy server 
-Pp proxy-server-port Specifies port number on the proxy server to use 
-Pu username password Specifies user name and password to use for proxy server 

login 
-B browser Specifies browser type to emulate 
-IP addr1,...,addrN Specifies IP addresses to use, for WebSpray PCs that have 

more than one IP address assigned 
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Appendix C 

Frequently Asked Questions 

 
Q. Can I stress test my server from an external network? 

A. Yes.  As long as the server can be reached from that network. 

 

Q. Can I test with multiple workstations at the same time? 

A. Yes.  You can use multiple workstations, each configured with one or more clients. 

 

Q. Can I test multiple servers simultaneously? 

A. The only way to test multiple servers is if they belong to a Web server farm where a load 
balancer distributes the traffic.  The IP address of the “Web Server” would be the IP 
address of the web farm. 
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Testing with multiple IP addresses 

Overview 
WebSpray is capable of generating a high volume of transactions when run from a single PC.  
By default, WebSpray running on a single PC will use a single IP address and simulate 
multiple clients by using multiple threads in parallel. 

To create a more realistic user environment, where each user has a different IP address, you 
may want to use one of the following methods to accomplish that: 

• Assign multiple IP addresses to a single WebSpray PC having a single network adapter 
(“local multihoming”) 

• Assign multiple IP addresses to a single WebSpray PC having multiple network 
adapter (“physical multihoming”) 

• Use multiple WebSpray PCs, each having one or more network adapters and/or 
assigned multiple IP addresses (“physical multihoming” and/or “logical multihoming”) 

Configuring WebSpray PC for Logical Multihoming 
WebSpray is capable of simulating multiple users by using multiple threads, as configured via 
the Number of Threads option.  By default, all such clients reflect the same IP address:  the IP 
address of the PC on which WebSpray is running on.  This is normally sufficient for most 
testing scenarios. 

There may be cases, however, in which you would like WebSpray to use different IP addresses 
for different clients.  To do so, you must configure multiple IP addresses on the WebSpray PC 
and enable them for use by WebSpray via the Client IP Addresses option.  Once this is done, 
WebSpray will randomly use all enabled IP addresses when testing. 

Windows allows multiple IP addresses to be configured for a single network adapter in a PC.  
This feature is called “logical multihoming” and is available in later versions of Windows.  The 
maximum number of IP addresses that can be assigned to a single network adapter depends 
upon the Windows version: 
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Windows NT 3.51 Maximum of 6 
Windows NT 4.0 Maximum of 25 
Windows 2000 Maximum of 25 
Windows XP Maximum of 25 

The procedure for assigning multiple IP addresses for a PC is described below. 

Which IP Addresses May be Assigned 
You must follow certain guidelines in determining which IP addresses may be assigned to the 
WebSpray PC.  Generally, such IP addresses need to meet the following three conditions: 

• They must be valid IP addresses 
• They must be allocated to your organization, and 
• They must not be assigned to or in use on other computers or devices 

Assigning IP addresses that do not meet the above criteria may cause invalid or unpredictable 
results, as WebSpray may be unable to receive responses on them.  Furthermore, using IP 
address that are not accessible to the network on which the WebSpray PC is connected or that 
are already in use by other computers can cause other network equipment to not function 
properly. 

Contact your Network Administrator if you are not sure which IP addresses may be safely 
assigned. 

Warning Assigning in-use IP addresses can cause equipment on your network to function 
improperly. WebSpray does not validate any IP addresses that are specified for its 
use.  

Limit of IP addresses that may be assigned 
The maximum number of IP addresses that may be assigned to the WebSpray PC is governed 
by Windows 
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Setting Multiple IP Addresses 
The procedure for setting multiple IP addresses varies by Windows version.  See the sections 
below for the installed Windows version on the WebSpray PC. 

Windows 2000 
1 Start -> Settings -> Network and Dial-up Connections -> 
2 Select ‘Internet Protocol (TCP/IP)’ and hit the Properties button 
3 Hit Properties button 
4 Select ‘Internet Protocol (TCP/IP)’ and hit the Properties button 
5 Enable the ‘Use the following IP address’ radio button 
6 Specify the first IP address, Subnet mask, and Default gateway to be configured for the 

PC 
7 Hit the Advanced… button 
8 On the IP Settings tab, hit the Add button 
9 Specify the IP address and Subnet mask for the next IP address to be configured for the 

PC 
10 Repeat steps 8 and 9 until all IP addresses have been configured 
11 Hit the OK button on the current and next two screens to complete the configuration. 

Note The PC may require rebooting upon completing the procedure for the new settings to 
take affect 
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Other windows versions 
To assign multiple IP addresses under other Windows versions, refer to the documentation for 
the Windows version you are using. 

 Configuring WebSpray PC for Physical Multihoming 
Unlike logical multihoming, in which multiple IP addresses are assigned to a single network 
adapter, “physical multihoming” uses multiple network adapters. 

The configuration process for physical multihoming is similar to that for logical multihoming, 
except because each network adapter needs to be on its own network having its own gateway,  

 

Testing Using Multiple WebSpray PCs 
To achieve maximum client test volume, you can use multiple PCs each running WebSpray.  
These PCs can be setup and configured for either physical or logical multihoming, or a 
combination thereof. 

When running WebSpray on multiple PCs, there is no coordination between them; so it is 
necessary to specify the same options on all the WebSpray PCs, start tests at the same time, 
and consolidate the results. 
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Appendix E 

Troubleshooting 

… 
… 

Common problems and resolutions 
The following table contains some common problems, their probable causes, and resolutions.  
If you do not see the problem you are experiencing and are unable to resolve it, contact CAI 
Networks, Inc. Technical Support per Appendix F. 

Problem Probable Cause Resolution 
Spray All button and 
menu option are 
disabled 

A scan has not been performed Perform a scan, then spray 

Spray Selected button 
and menu option are 
disabled 

Either 1) a scan has not been 
performed or 2) no URLs have been 
selected 

1) Perform a scan, then 
spray or 2) select at least 
one URL 

Client IP Addresses 
menu option is 
disabled 

There is only one IP address 
assigned to the WebSpray PC 

Assign additional IP 
addresses to the WebSpray 
PC 

No pages are qualified 
by scan 

The correct protocol for the head 
page was not specified 

Specify the correct protocol 
for the head page 

Expected pages are 
missing from scan 
report 

They did not qualify based on the 
Web server and/or Target Scope 
specification 

Correct the Web server 
and/or Target Scope 
specification and re-scan 

… … … 
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Execution Log File 
Every time the GUI or CLI is run an execution log file is automatically generated in the 
installation directory (/Program Files/CAI Networks/WebSpray).  The GUI generates a file 
with the following name structure:  WebSpray-YYYYMMDD(#).log.  The CLI generates: 
WebSpray Command Line-YYYYMMDD(#).log.  Where YYYY is the year, MM is the 
month, DD is the day, and (#) is the number of sessions run. 

The execution log file contains more detailed information on WebSpray’s activities during the 
scan and spray modes.  Should a test run not go as expected, the information in these log files 
may be helpful in pinpointing the problem. 

The execution log files are not automatically deleted and can quickly accumulate after 
numerous test runs.  It is recommended you periodically delete the unneeded log files to save 
hard drive space. 
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Technical Support 

Introduction 
CAI Networks, Inc. provides a variety of support options to help you get the most from 
WebSpray.  This appendix describes these options. 

Internet Support 
For up-to-date support information, visit our web site at www.cainetworks.com and go to the 
Support page.  You can lodge a support request there by filling out the form.  It will be sent to 
our Technical Support specialists and you will receive a response by email or telephone. 

Email Support 
You can send your support request to our Technical Support department via email.  The 
address is: 

 support@cainetworks.com 

Be sure to include sufficient information about your configuration and question or problem so 
that we may provide a complete reply.  If your issue is related to a particular public Web 
server, please include the URL of that server so that we may attempt to reproduce the problem. 
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